
 

Certified according to ISO 9001:2008 

 

 

PERFILÔMETRO DE RODAS A LASER 
 

Série MPRC-BR 
 
 

Manual do Usuário (Português) - 2023 
 

 

 
BRASIL: 

CAPI Controle e Automação 

Rua Itororó, 121 – Americana-SP 
(19) 3604.7068 / 3468.1791 
www.capicontrole.com.br 



LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

2 

Conteúdo 

1. Precauções e Condições de Medição ......................................................................................................... 7 

2. Compatibilidade Eletromagnética ................................................................................................................. 7 

3. Segurança do Laser....................................................................................................................................... 7 

4. Informação Geral ........................................................................................................................................... 7 

5. Dados técnicos básicos ................................................................................................................................. 8 

6. Exemplo de designação no pedido .............................................................................................................. 8 

7. Configuração completa fornecida ................................................................................................................. 9 

8. Estrutura........................................................................................................................................................ 10 

8.1. Componentes básiscos do dispositivo e suas funções .................................................................... 10 

8.1.1. Dispositivo de leitura Digital ...................................................................................................... 11 

8.1.2. Módulo Scanner Laser ............................................................................................................... 12 

8.1.3. Bloco de calibração .................................................................................................................... 14 

9. Princípio de Operação ................................................................................................................................. 14 

10. Parâmetros Geométricos da roda sob controle .................................................................................... 14 

10.1. Altura do Friso / Aba (Flange height), sH ....................................................................................... 14 

10.2. Espessura do Friso / abas (Flange thickness), sD, sD1 ............................................................... 15 

10.3. Desnível do friso / ângulo de flanco (Flange slope), qR ............................................................... 16 

10.4. Parâmetros de desgaste .................................................................................................................. 16 

10.5. Parâmetros angulares de perfil ....................................................................................................... 18 

10.6. Parâmetros da pista ......................................................................................................................... 18 

10.7. Diâmetro da roda .............................................................................................................................. 18 

10.8. Parâmetros de rodas de bonde ....................................................................................................... 19 

10.9. Defeitos na Roda .............................................................................................................................. 20 

11. Sistema de Coordenadas ........................................................................................................................ 20 

12. Primeira ativação e procedimento de medição ..................................................................................... 20 

12.1. Ativação ............................................................................................................................................. 20 

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

3 

12.2. Medição (Measurement) .................................................................................................................. 21 

13. Ajuste dos parâmetros básicos do PDA ................................................................................................ 24 

13.1. Modo de Medição (Measurement type).......................................................................................... 24 

13.2. Unidades de medida ........................................................................................................................ 24 

13.3. Ajuste de Data/Hora (Date/time setting) ........................................................................................ 25 

13.4. Seleção de Dispotivo (Device selection) ........................................................................................ 25 

13.5. Escolha de linguagem (Language setting) ..................................................................................... 27 

13.6. Sincronização com PC ..................................................................................................................... 27 

14. Ajuste dos Parâmetros de Medição ....................................................................................................... 28 

14.1. Configuração dos métodos de Cálculo .......................................................................................... 29 

14.2. Seleção dos parâmetros exibidos ................................................................................................... 29 

14.3. Configuração dos Parâmetros L ..................................................................................................... 29 

14.4. Valores pré-setados de parâmetros (configuração original) ........................................................ 30 

15. Ajustando os parâmetros do banco de dados, tolerâncias e esquemas de medição ....................... 31 

15.1. Seleção do banco de dados atual................................................................................................... 31 

15.2. Seleção e instalação de perfis de referência ................................................................................. 32 

15.2.1. Escrevendo perfil de referência no banco de dados .............................................................. 33 

15.3. Seleção e formação do esquema de medição .............................................................................. 33 

15.3.1. Seleção ou remoção do esquema de medição ....................................................................... 33 

15.3.2. Criação de um novo esquema de medição ............................................................................. 34 

15.3.3. Carregando um novo esquema de medição ........................................................................... 34 

15.4. Programação de tolerâncias............................................................................................................ 34 

15.5. Seleção e instalação de tipo de roda ............................................................................................. 35 

16. Atualizando o software do PDA software .............................................................................................. 37 

17. Desligar ..................................................................................................................................................... 37 

18. Medições com manutenção de banco de dados .................................................................................. 37 

18.1. Medição ............................................................................................................................................. 39 

18.2. Medição de desgaste regular / irregular (even/uneven wear) ...................................................... 41 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

4 

18.3. Medição de defeitos ......................................................................................................................... 42 

19. Medindo com MPRC, MBRC, MDRC, e salvando no banco de dados .............................................. 42 

20. Buscando no banco de dados ................................................................................................................ 43 

20.1. Filtragem de dados ........................................................................................................................... 44 

20.2. Visualização do perfil da roda ......................................................................................................... 44 

21. Instalação e inicialização do software no PC ........................................................................................ 45 

21.1. Instalação do software de suporte de banco de dados ................................................................ 45 

21.2. Sincronização do PDA com o PC ................................................................................................... 46 

21.3. Iniciando o Programa ....................................................................................................................... 46 

22. Ajustes do usuário .................................................................................................................................... 47 

22.1. Ajuste de parâmetros (Parameters setting) ................................................................................... 47 

22.1.1. Aba Parâmetros das Rodas ("Wheelset's parameters") ......................................................... 47 

22.1.2. Aba Parâmetros Calculados "Calculated parameters" ........................................................... 48 

22.1.3. Aba Parâmetros L ("L parameters") ......................................................................................... 48 

22.1.4. Aba Método de Medição ("Measurement method") ................................................................ 48 

22.1.4.1. Seleção das unidades de medida .................................................................................... 49 

22.2. Ajustes de banco de dados (Database settings) ........................................................................... 49 

22.2.1. Selecionando caminho do banco de dados ............................................................................. 49 

22.2.2. Criação de um banco de dados vazio ...................................................................................... 50 

22.2.3. Importação de banco de dados ................................................................................................ 50 

22.2.4. Seleção de idioma ...................................................................................................................... 51 

22.2.4.1. Preparação e instalação do arquivo de suporte a idioma .............................................. 51 

22.3. Dados de Registro ............................................................................................................................ 52 

22.3.1. Seleção da organização ............................................................................................................ 52 

22.3.2. Registro de operadores ............................................................................................................. 52 

22.3.3. Registro de séries ...................................................................................................................... 53 

22.3.4. Registro dos números do carro/locomotiva ............................................................................. 53 

22.3.5. Registo de tolerâncias ............................................................................................................... 54 

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

5 

22.3.6. Registro de perfis de referência ................................................................................................ 54 

22.3.6.1. Requisição e registro do arquivo de perfil ....................................................................... 56 

23. Troca de dados entre PDA e PC ............................................................................................................ 56 

23.1. Sincronização ActiveSync ............................................................................................................... 56 

23.1.1. Transferir arquivo de banco de dados para o PC ................................................................... 56 

23.1.2. Transferir arquivo de idioma do PC para PDA ........................................................................ 57 

23.1.3. Transferência de arquivo de idioma do PDA para o PC ........................................................ 58 

23.1.4. Transferência do arquivo de perfil de referência do PC para o PDA .................................... 59 

23.1.5. Transferência do arquivo de esquema do PC para o PDA .................................................... 59 

23.1.6. Atualizando o software do PDA ................................................................................................ 60 

23.2. Sincronização Armazenamento de Massa .................................................................................... 61 

24. Trabalhando com perfis e cálculos de desgaste ................................................................................... 62 

24.1. Buscando o gráfico e as coordenadas do perfil ............................................................................ 62 

24.2. Aba Parâmetros ................................................................................................................................ 63 

24.2.1. Seleção do perfil de comparação ............................................................................................. 63 

24.2.2. Seleção dos valores de parâmetros L- .................................................................................... 63 

24.2.3. Parâmetros geométricos do perfil ............................................................................................. 64 

24.3. Cálculo de desgaste ......................................................................................................................... 64 

24.3.1. Cálculo rápido de desgaste ....................................................................................................... 64 

24.3.2. Cálculo de desgaste em todos os pontos ................................................................................ 64 

24.4. Alinhamento de Perfis ...................................................................................................................... 66 

24.5. Sobreposição de Perfis .................................................................................................................... 67 

24.6. Escala (zoom) ................................................................................................................................... 67 

25. Implementação da função de torneamento mínimo ............................................................................. 68 

26. Buscando e editando dados .................................................................................................................... 69 

26.1. Pesquisando e filtrando dados ........................................................................................................ 69 

26.2. Edição de dados ............................................................................................................................... 71 

26.3. Geração de Relatórios ..................................................................................................................... 72 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

6 

26.3.1. Relatório em Excel ..................................................................................................................... 73 

26.3.2. Relatório para impressão .......................................................................................................... 73 

27. Fazendo medições via PC (sem PDA)................................................................................................... 74 

27.1. Calibração ......................................................................................................................................... 75 

27.1.1. Instalação da conexão Bluetooth .............................................................................................. 75 

27.1.2. Calibração do Perfilômetro ........................................................................................................ 76 

27.2. Medição usando PC ......................................................................................................................... 77 

27.2.1. Salvando os dados ..................................................................................................................... 78 

28. Anexo 1: Procedimento de recarga ........................................................................................................ 78 

29. Anexo 2: Programa para criação de esquemas de medição ............................................................... 78 

30. Anexo 3: Teste e calibração .................................................................................................................... 80 

Testing and calibratio .......................................................................................................................................... 80 

30.1. Preparação para teste/calibração ................................................................................................... 81 

30.2. Teste .................................................................................................................................................. 82 

30.3. Calibração ......................................................................................................................................... 82 

31. Garantia..................................................................................................................................................... 83 

32. Distribuidor e Suporte Técnico no Brasil................................................................................................ 83 

  

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

7 

1. Precauções e Condições de Medição 
 Antes de montar o perfilômetro na roda, as áreas de contato dos suportes 

laterais com a superfície da roda, devem estar limpas. 

 Quando montar o modulo sobre a roda, evitar choques fortes do suporte contra 
a roda. 

 A superfície de saída do laser do perfilômetro e os seus suportes devem ser 
cuidadosamente inspecionados e limpos. 

 Não utilize o laser em locais próximos a fontes luminosas potentes.  
. 

2. Compatibilidade Eletromagnética 
O perfilômetro foi desenvolvido para uso em indústria e atende os requisitos dos 

seguintes padrões: 

 EN 55022:2006 Information Technology Equipment. Radio disturbance 
characteristics. Limits and methods of measurement.  

 EN 61000-6-2:2005 Electromagnetic compatibility (EMC). Generic standards. 
Immunity for industrial environments. 

 EN 61326-1:2006 Electrical Equipment for Measurement, Control, and 
Laboratory Use. EMC Requirements. General requirements. 

3. Segurança do Laser  
O perfilômetro faz uso de um laser semicondutor c.w. comprimento de onda: 660 

nm. Máxima potência de saída é 1 mW. O dispositivo pertence a classe de segurança de 
laser 2. O seguinte alerta está colocado no corpo do perfilômetro. 

 

As seguintes precauções devem ser adotadas quando o perfilômetro for usado: 

 Não direcione o feixe do laser para humanos; 

 Não desmonte o sensor; 

 Evite olhar diretamente para o feixe do laser. 

4. Informação Geral 

O Perfilômetro a laser Série MPRC foi projetado para medição de: 

 Altura do friso da roda 

 Espessura do friso da roda 

 Desnível no friso da roda 

 Espessura da pista da roda 

 Escaneamento e análise completa do perfil da superfície da pista da roda 

 Armazenamento eletrônico do banco de dados do desgaste 

 Controle das tolerâncias e classificação durante o checkup, inspeção,reparo e 
disposição das rodas ferroviárias. 
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As medidas são tomadas no material rodante, sem precisar remover as rodas. 
Estão disponíveis duas configurações: com a alça padrão e com a alça compacta (versão 
curta). Esta versão curta é destinada para medir as rodas quando o espaço para 
instalação do perfilômetro é limitado. 

5. Dados técnicos básicos 
 

Parâmetro Valor 

Range de medição  
Altura do friso  (flange height), mm       
Espessura do friso (flange thickness), mm 
Desnível do friso (flange  slope), mm 
Espessura da bandagem – opcional (rim thickness), mm 
Diâmetro (calculado) - diameter (calculation method), mm 

20…45 
20…50 
1…15 

36…100 (30...90) 
400…1400 

Erro de medição  
Altura do friso  (flange height), mm       
Espessura do friso (flange thickness), mm 
Desnível do friso (flange  slope), mm 
Espessura da bandagem– opcional (rim thickness), mm 
Diâmetro (calculado) - diameter (calculation method), mm 

± 0,03 
± 0,03 
± 0,1 
± 0,1 
± 0,1 

Discrição da indicação   

todos os parâmetros, mm  0,01 

Range de medição do perfil, mm 145  (ou consultar modelos especiais) 
Discrição de formação do perfil, não maior do que, mm 0,025 (5800 pontos por perfil) 

Dimensões do leitor digital (PDA), mm ver Fig. 3 
Dimensões do módulo scanner laser, mm ver Fig. 5 (obs: modelo padrão) 

Fonte de alimentação (scanner laser)  3.7V 
Li-ion rechargeable battery 

5400mAh para modelo padrão 
2400mAh para versões compactas 

Fonte de alimentação (PDA)  3,7V 
Li-polymer battery 

3300mAh 
N° de medições antes da recarga da baterial não inferior a  5000 / (2200 para compactas) 

Memória do PDA 100 000 medições 

Interface entre scanner laser e PDA Bluetooth  

Temperatura de trabalho, °С -20…+50 

Grau de proteção IP42 ou IP64 

6. Exemplo de designação no pedido 
 

Obs: Devido às variações do material rodante brasileiro e a variabilidade de recursos opcionais e 

atualizações, recomendamos fortemente confirmar a codificação junto à equipe da CAPI Controle para 

codificação adequada. 
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MPRC-5-T-BR-668 

Symbol Description 

Short Versão com manopla curta 

M Opções dos magnetos para montagem na face externa/interna da pista: 
S – standard (default) 
F – reforçados 

S Opções do corpo da placa de suporte: 
D – direto. Padrão, perfilômetro é montado na face interna. 
I – invertido. Perfilômetro é montado na face externa. 

T Presença da haste de medição da bandagem. Consultar CAPI para versão correta 

T90 Presença de suportes especiais para medição da bandagem por meio de laser 
(segunda etapa a 90°). Inclui software com função adicional. 

BP Bloco de calibração opcional 

BR-668 Menus e manuais em português e suporte técnico no Brasil 

7. Configuração completa fornecida 
 

Name Quantity Weight, 
kg 

PDA 1 0,3 

Módulo de scanner laser 1 0,8 

Carregador para o PDA 1 0,2 

Carregador para o Módulo Laser 1 0,2 

Cabo de dados 1  

Bluetooth/USB – adaptador 1  

Maleta 1 1,2 

Sistema de gerenciamento do banco de dados (CD) 1  

Manual do usuário 1  

Menus e manuais em português e suporte técnico e 
garantia no Brasil 

1  

Ferramentas de calibração (opcional):   

Bloco de calibração  4 

Sofwtare de calibração   
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O perfilômetro é fornecido em uma 
maleta especial para melhor proteção / 
conservação. 

 

8. Estrutura 

8.1. Componentes básiscos do dispositivo e suas funções 
Fig. 1 componentes básicos: 

 
Figura 1 

(1) Dispositivo de leitura PDA (personal digital assistant)  
(2) Módulo scanner laser 
(3) Bloco de calibração 
(4) Carregador 
(5) Cabo de dados   

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

11 

8.1.1. Dispositivo de leitura Digital 
PDA é projetado para o controle do Módulo Laser, recebimento de dados do 

módulo laser, indicação dos resultados das medidas, entrada de parâmetros e 
armazenamento de dados. 

  
Figura 2 

Fig. 2 indica: 
(1) Botão de LIGA 
(2) Indicador de bateria, LED vermelho/verde 
(3) Porta USB – Conexão com PC ou carregador 
(4) Entrada para cartão de memória 
(5) Stylus – Caneta para touch screen 
(6) Antena Bluetooth 

Dimensões do PDA mostradas na figura 3: 

 
Figure 3 
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8.1.2. Módulo Scanner Laser  
Esse módulo é responsável pelo escaneamento a laser da superfície da roda. 

 
Figura 4 

(1) Botão ON (LIGA) 
(2) Indicador ON (LED vermelho) 
(3) Indicador de conexão Bluetooth (LED azul) 
(4) Conexão para o carregador 
(5) Suporte para montagem do dispositivo no friso da roda 
(6) Base magnética para montagem na superfície lateral da roda. 
(7) Indicador da bateria, LED vermelho/verde 
(8) Janela de saída 
(9) Haste de medição da bandagem (obs: foto ilustrativa. Esta peça é 

customizada para curvatura de rodas modelo Brasil). 

 

Figura 5: Dimensões do módulo scanner padrão (orientativas) 
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Figura 6: Dimensões do módulo scanner manopla compacta (Short) (orientativas) 

 
Figura 6.1: Dimensões módulo scanner manopla super compacta (SShort) (orientativas) 

 

 

Figura 6.2: Dimensões scanner super compacto Bateria Externa (SSEB) orientativas 
 

Obs: pode haver variações dimensionais e modelos especiais, bem como calibrações 
específicas. Consulte em caso de limitações. 
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8.1.3. Bloco de calibração 
O bloco de calibração permite a calibração e testes do perfilômetro. Esse bloco 

é uma imitação metálica de parte da roda com um perfil definido. 
Dimensões do bloco de calibração são mostradas na figura 1A do parágrafo 30.3. 

Também é possível o fornecimento de uma unidade com o perfil feito a partir dos 
desenhos do cliente. 
 

9. Princípio de Operação 
O operador monta o Scanner Laser sobre a roda a ser medida. Ao receber o 

comando via PDA ou PC, o módulo laser executa o escaneamento sem contato da 
superfície da roda. Os resultados da medida (parâmetros geométricos e perfil da 
superfície) são mostrados na tela do PDA e podem ser salvos em sua memória e 
transferidos para o computador. Simultaneamente, parâmetros adicionais podem ser 
salvos: número/nome do operador, indicação do lado (roda direita ou esquerda), número 
do eixo, número do carro, número do rodeiro, etc 
 
Vídeo de demonstração: solicitar a capi@capicontrole.com.br  

 

10. Parâmetros Geométricos da roda sob controle  
Parâmetros geométricos da roda são calculados automaticamente depois que o 

escaneamento a laser da roda for completado. Para calcular os parâmetros geométricos, 
é feito uso de pontos de referência no perfil da roda. Os pontos de referência são 
definidos pelos Parâmetros L- e P-. Os valores para os parâmetros L- e P- presentes no 
PDA são dados no parágrafo 14.4. e podem ser alterados pelo usuário. 
 

10.1. Altura do Friso / Aba (Flange height), sH 
O ponto de medida da altura do friso é determinado pelo parâmetro L2. 
A altura do friso é calculada como a disância medida verticalmente entre o topo 

do friso e o ponto da superfície rodante a uma distância pré-selecionada (L2) da face 
interna da roda. 

 
 
VERSÃO PONTE ROLANTE: Quando selecionado o modo “Crane”, a altura do friso sH 
é utilizada no cálculo do Diâmetro na banda de rodagem (ponto L2), considerando que 
não há desgaste no topo do friso nem reperfilamento.  

http://www.capicontrole.com.br/
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10.2. Espessura do Friso / abas (Flange thickness), sD, sD1 
O ponto do cálculo da espessura do friso é determinado pelo parâmetro L3, que 

especifica o Ponto 1 da superfície do friso. Há duas opções de especificação para este 
parâmetro:  
 

Método 1 

 
 
 

Altura L3 é medida verticalmente 
para cima a partir de um ponto da 
superfície rodante, o qual é 
definido pelo parâmetro L2. 

 

Método 2 

 

Altura L3 é medida verticalmente 
para baixo a partir do topo do friso. 

 
A espessura do friso é calculada como a distância medida horizontalmente a uma 

altura pré-selecionada (L3) entre dois pontos (Pontos 1 e 2) entre os lados opostos do topo do 
friso. 

Há 2 opções para o cálculo da espessura do friso: 

 

Método 1 

 

Ponto 1 – a posição em altura é definida 
pelo parâmetro L3. 
Ponto 2 – o ponto de intersecção de uma 
linha horizontal com a linha apoiada na 
face interna da roda. 

Método 2 

 

Ponto 1 – a posição em altura é definida 
pelo parâmetro L3. 
Ponto 2 – o ponto de interdecção de uma 
linha horizontal com a superfície do friso.  

Nota: Cálculos para ambos os métodos podem ser efetuados e exibidos 
simultaneamente. 
 
VERSÃO PONTE ROLANTE: Quando selecionado o modo “Crane”, podem ser 
exibidas as espessuras das duas abas, respectivamente sD e sD1.  
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10.3. Desnível do friso / ângulo de flanco (Flange slope), qR 
Os pontos de cálculo do desnível do friso são determinados pelos parâmetros L1 

e L3 (ou L4). 

Altura L1 é medida verticalmente para baixo a 
partir do topo do friso e determina o Ponto 3 
da superfície do friso. 
A altura L4 é medida verticalmente para cima 
a partir de um ponto da superfície de 
rodagem, o qual é definido pelo parâmetro L2 
(círculo da banda de rodagem), e determina o 
Ponto 4 da superfície do friso. 
A altura L3 é descrita no parágrafo 10.2. 

 

 
Há 3 opções para o cálculo/indicação do desnível do friso: 

 

Método 1 
Cálculo em milímetros 

 

O desnível é calculado como a distância, medida 
horizontalmente  entre Ponto 3 e Ponto 1 (ou 4). A 
informação é exibida no PDA em milímetros. 

Método 2 
Cálculo em graus 

 

O desnível do perfil medido é calculado como o 
ângulo de inclinação de uma linha reta passando 
pelos pontos 3 e 1 (ou 4).  
A infornação é exibida no PDA em graus. 

Método 3 
Passa/Falha (Pass/Fail) 

 

O cálculo é feito de acordo com o método 1. 
Na tela do PDA aparece apenas a informação de que 
o desnpivel está ou não está dentro das codnições 
de tolerância.  

10.4. Parâmetros de desgaste 
Os seguintes parâmetros de desgaste são calculados automaticamente: 

Desgaste 
vertical   

Wt Calculado como a diferença entre a altura do friso medida e a altura do friso de 
referência selecionada. 

Desgaste 
Horizontal  

Wf Calculado como a diferença entre a espessura do friso medida e a espessura 
do friso de referência na altura L3.  

Desgaste 
Angular  

Wr Calculado como a distância ao longo da normal à tangente em um ponto na 
altura L5 da superfície de rodagem do perfil medido e a referência selecionada.  
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* Linha vermelha indica um perfil desgastado  

Cavidade/cava 
(Hollow) 

Hl Calculado como a diferença entre o máximo e o mínimo dentro de limites 
especificados.  
Limites de busca: 
- parâmetros de valor mínimo [P7_1..P7_2] 
- parâmetros de valor máximo [P8_1..P8_2] 
Versão cava deslocada (somente P7 e P8): 
- parâmetros de valor mínimo [P7] 
- parâmetros de valor máximo [P8] 

 

Diferença de 
diâmetros 

dD Calculados como a diferença entre o diâmetro no ponto D1 e o diâmetro no 
ponto D2.  

 

Desgaste 
regular  
(Even wear) 

W1 O desgaste vertical máximo, selecionado de um conjunto de medições. 

Desgaste 
irrregular  
(Uneven wear) 

W2 O desgaste de roda máximo menos o desgaste mínimo (de um conjunto de 
medições em diferentes pontos da roda)  
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10.5. Parâmetros angulares de perfil 
Os seguintes parâmetros de perfil são calculados automaticamente: 

Inclinação A Calculado como o ângulo de inclinação do perfil (em graus) em um ponto de 
coordenada L8 

Ângulo 1 S1 Calculado como o ângula de inclinação de uma linha reta (em percentual) 
passando pelos pontos na superfície da toda localizados a uma distância 
determinada L6 da face da roda, e a distância L6+10mm da face da roda 

Ângulo 2 S2 Calculado como o ângula de inclinação de uma linha reta (em percentual) 
passando pelos pontos na superfície da toda localizados a uma distância 
determinada L7 da face da roda, e a distância L7+10mm da face da roda 

 

10.6. Parâmetros da pista 
Os seguintes parâmetros são calculados automaticamente:  

Largura da pista 
(Rim width) 

L  
 

Calculada como a distância, medida verticalmente entre a superfícies 
interna e externa da superfície da roda  

Espessura da pista 
(Rim thickness) 

sT  
 

Calculada como a distância, medida verticalmente entre o diâmetro 
interno da pista e e um ponto na banda de rodagem, localizado a uma 
distância determinada L2 da face da roda.  

L11 é um diâmetro externo da roda 

 

10.7. Diâmetro da roda 
Diâmetro D  

 
Calculado pela fórmula: 
D = 2*T +L10,  
T – espessura da pista 
L10 – diâmetro do centro da roda 
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Diâmetro 
Ponte rolante 

D  
 

Calculado pela fórmula: 
D = D0 – 2 x (sH - sH0),  
D0 – diâmetro roda nova 
sH – altura da aba 
sH0 – altura da aba roda nova 

 

10.8. Parâmetros de rodas de bonde 
Os seguintes parâmetros de rodas de bonde são calculados automaticamente:  

Espessura do friso 
(Flange thickness) 
 
 

sD15  
 

Calculada como a distância, medida horizontalmente a uma altura 
determinada (L15) entre dois pontos: 1º ponto na superfície interna do 
friso, 2º ponto na linha apoiada sobre a face interna da superfície da roda 

Espessura do friso 
(Flange thickness) 
 

Df  
 

Calculada como a distância, medida horizontalmente em uma altura 
determinada (L3) da superfície da banda de rodagem da roda, entre dois 
pontos apoiados em lados opostos do topo do friso. 

Inclinação reversa 
(Reverse slope) 
 

f  
 

Calculada como a distância, medida horizontalmente do ponto no lado 
interno do friso a uma altura determinada (L3), ao ponto na linha apoiada 
na face interna da roda. 

 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

20 

10.9. Defeitos na Roda 
Os seguintes parâmetros de defeitos na superfície da roda são calculados: 

Slide sP  
 

Calculado como a diferença das medidas de desgaste em 
duas posições da roda: no local do declive e próximo a ele 
(na posição sem defeitos) no ponto da banda de rodagem 
a qualquer distância programada (L2) da face da roda. 

Cavity size hR Calculado como a diferença de desgaste em duas posições 
da roda: na cavidade e próximo a ela (na parte sem 
defeitos) em qualquer ponto do perfil. 

Cavity area sR Calculada no local com o máximo desvio. 

11. Sistema de Coordenadas 
Na comparação de perfis, duas variantes de posicionamento do sistema 

coordenado são possíveis. 

Origem do sistema de coordenadas 

Topo (Top) 
Ao comparar e exibir os perfis, a origem do 
sistema de coordenadas é localizada na 
intersecção das linhas que tangenciam o topo 
do perfil e a superfície interna da roda.  

 

Banda de rodagem (Wheel rolling 
circle) 

Ao comparar e exibir os perfis, a origem do 
sistema de coordenadas é localizada no ponto 
de intersecção das linhas, passando através do 
centro da banda de rodagem.  

 

12. Primeira ativação e procedimento de medição 
Carregue as bateriais do módulo laser e dispositivo indicados (PDA) conectando-

os aos respectivos carregadores (ver par. 28).  

12.1. Ativação 
 Ligue o PDA pressionando o botão (1), Fig. 2. A tela do PDA mostrará a 

janela principal do programa contendo: menu principal; indicadores do nível 
de bateria do PDA e do módulo laser; indicador da conexão Bluetooth.  
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Botão Função 

Dispositivo Ajuste dos parâmetros básicos do PDA (p.13)  

Parametros Ajuste dos parâmetros de medição (p.14) 

Ajustes Programação dos parâmetros de banco de dados, tolerâncias, e outros (p.15) 

Perfis Visualização dos perfis das rodas (p.20.2.) 

Medição Executar o processo de medição (p.12.2.) 

 Ligue o módulo laser pressionando e segurando o botão 1 (Fig. 4) por alguns 
segundos. Durante a conexão do módulo laser, um LED vermelho pisca (2).  

 Após ligar o módulo laser, levará algum tempo até que a comunicação wireless 
se estabeleça entre o perfilômetro e o PDA, o que é acompanhado pelo piscar 
do LED azul (3) no módulo laser. O LED se apaga quando o link é estabelecido.  

 A janela principal do programa então será atualizada.  

 
O botão Measurement, indicador da conexão Bluetooth, núemro de série do 

scanner laser, e indicadores do nível de carga de bateria estarão ativos.  

12.2. Medição (Measurement) 
Há dois modos de medição: 
1. Medições Rápidas sem o registro dos resultados. 
2. Medições usando o esquema selecionado e salvando os resultados no banco 

de dados. 
O procedimento de medição no modo 2 é descrito no par. 18. Como selecionar o 

modo de medição, ver par. 13.1.  
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Medições usando o esquema (modo 2) são usadas para o trabalho completo com 
o perfilômetro e armazenando e mantendo as medições no banco de dados.   
 

 

 

Atenção!  
Antes de instalar o scanner laser na roda, limpar as áreas sujas, nas quais os suportes de fixação 
do módulo laser fazem contato com a superfície.  
Ao instalar o módulo laser na roda evite impactos fortes do suporte contra a roda, pois isso pode 
levar a operação incorreta do perfilômetro.  

 

 

Inspecione preiodicamente a janela de saída e os suportes do módulo laser scanner e limpe-as 
se necessário.  
Nunca limpar o vidro usando materiais abrasivos e agentes de limpeza agressivos.  

 
Para executar uma medião única é necessário: 

 Fixar o módulo laser no bloco de calibração ou roda pelo suporte de montagem 
(5) na flange da roda e pressionando o suporte magnético (6) contra a face 
interna da roda. 

 Para a medição do aro (pista), extraia a haste de medição e encaixe-a sob o 
aro. 

 
Figure 6 

 Certifique-se de que o módulo está corretamente montado, sem 
desalinhamentos ou folgas. 

 Pressione o botão Measurement no display do PDA. 

 Pressionado o botão Measurement, o módulo laser module escaneará a 
superfície da roda. Durante o período de scan (1-2 seg.) um LED vermelho (2) 
se acende.  

 Quando o escaneamento é completado, o PDA mostra os valores dos 
parâmetros selecionados para apresentação (ver par.14.2.).  

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

23 

 

 

Quando o parâmetro está dentro dos limites de tolerância programados, seu valor 
aparece em azul. 
 

Quando o parâmetro está fora dos limites de tolerância programados, seu valor 
aparece destacado em vermelho:  

 

 A opção Reference habilita/desabilita a exibição dos parâmetros do perfil 
de referência na tela (destacados em verde). 

 Para visualizar o perfil da roda clique no botão Profile, e o PDA mostrará o perfil 
da roda escaneada, os parâmetros medidos, e os parâmetros do bloco de 
calibração (ou do modelo de roda, escolhido como referência): 

 
 Se vocês escaneou o bloco de calibração ou a roda de referência e os 

resultados diferiram dos valores de referência em não mais que 0.1 mm, o 
dispositivo está pronto para o uso, caso contrário ele deve ser calibrado de 
acordo com o par. 27.1 ou 30. 

 
O botão Save não fica ativo no modo Rapid measurements 
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13. Ajuste dos parâmetros básicos do PDA  
Antes de começar a trabalhar com o perfilômetro, o ajuste do programa do PDA 

deve ser executado. 
A janela dos parâmetros básicos é acessada clicando no botão Device na janela 

do menu principal (par. 12.1.): 

 

Botão Função 

Measure type Medição rápida (Rapid Meas.) / medição por esquema (by scheme) 

Units of measurement Milímetros / polegadas 

Date/time Ajuste de Data/hora 

Device type  Seleção do dispositivo (IKP, IDK, IМR) 

Language Seleção de linguagem 

Synchronization Sincronização com PC  

13.1. Modo de Medição (Measurement type) 
Há dois modos de medição: 
1. Medição rápida (sem gravação dos resultadis) 
2. Medições por esquema selecionado salvando resultados no banco de dados. 
Para selecionar o modo, clique em Measure type. Então selecione o modo de 

medição: Rapid measurement ou Measurement by scheme. Clique no botão Save. 

 

13.2. Unidades de medida 
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Todos os parâmetros e resultados de medição podem ser apresentados no 
sistema métrico (milímetros), ou no sistemna inglês (polegadas). Para selecionar a 
unidade de medida, clique em Units e depois selecione Millimeters (mm) ou Inches 
(in), e clique em Save. 

 

13.3. Ajuste de Data/Hora (Date/time setting) 

Para ajustar data e hora, clique em Date/Time. A seguir use os botões    
para ajustar os valores de data e hora e clique em Save.   

 

13.4. Seleção de Dispotivo (Device selection) 
 A conexão Bluetooth do PDA é automaticamente ajustada para trabalhar com o 

módulo scanner laser que acompanha o PDA. Além disso, o PDA pode ser usado com 
outros scanners MPRC/IKP e instrumentos de medição para ferrovias RIFTEK-CAPI 
(Medidor de diâmetro de rodas, Medidor de bitola Back-to-Back, Perfilômetro de trilhos). 

Para conectar outro disposoitivo, clique em Device type. A janela de seleção de 
dispositivo contém 3 tipos de dispositivo que podem ser conectados: IKP, IDK, IMR.  

Cada tipo de dispositivo tem uma lista de dispositivos disponíveis (dispositivos 
que já foram conectados anteriormente a este PDA e que foram salvos em sua memória). 
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Se o dispositivo que você necessita está incluso na lista, você pode selecioná-lo 
na lista e clicar em Select. Em seguida o PDA tentará sempre se conectar com este 
dispositivo como padrão. 

Se o dispositivo não está na lista, você pode adicioná-lo. Para isso, clique no 
botão Add e passe para a janela de busca de dispositivos Bluetooth. 

 

Para buscar os dispositivos que estão disponíveis, clique em Start e aguarde a 
busca ser completada: 

 

Dispositivos detectados (com números de série) aparecerão na tela:  

  

A seguir, selecione o dispositivo e clique no botão Save para gravar o endereço 
de um novo dispositivo.  
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Você também pode deletar da lista um dispositivo que não deseja mais usar, 
selecionando-o e clicando no botão Delete. 

 

13.5. Escolha de linguagem (Language setting) 
É possível alterar a língua do programa para seu próprio arquivo de linguagem, 

bem como alterar/ediatr a terminologia usada.  
Para selecionar a linguagem, clique no botão Language. A seguir, selecione o 

arquivo de suporte desejado e clique no botão Select. 

 

Se não há arquivo disponível, é preciso usar o procedimento de preparação de 
novos arquivos, que é descrito no par. 22.2.4.1., e então carregar o novo arquivo de 
linguagem do PC para o PDA conforme mostrado no par. 23.1.3. 
 
 

13.6. Sincronização com PC 
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Para transferir dados entre o PDA e o PC, é preciso sincronizá-los. Há duas 
formas de sincronização via cabo USB. 

Quando você seleciona MS ActiveSync, a sincronização é feita via software 
ActiveSync (Windows XP), ou via Windows Mobile Device Center (Windows 7).   

Quando você seleciona Mass Storage, o dispositivo é detectado pelo Windows 
como um dispositivo de armazenamento externo. 

Para selecionar o tipo de sincronização, clique em Synchronization na janela 
Device. A seguir, selecione sua opção e clique em Save. 

 

Para aplicar as mudanças, o PDA pedirá que você reinicie. Se você não precisa 
sincronizar o PDA com o PC neste momento, você pode reiniciá-lo mais tarde. 

 

14. Ajuste dos Parâmetros de Medição 
A janela Parameters, acessada do menu principal, é destinada à configuração 

para os cálculos dos parâmetros da roda a ser controlados. 

 

Botão Função 

Settings Configuração dos métodos de cálculo 

Show param. Seleção dos parâmetros a serem exibidos 

L Parameters Configuração dos parâmetros L 
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14.1. Configuração dos métodos de Cálculo  
Para selecionar o método de cálculo dos parâmetros geométricos, clique em  

Settings. A janela de ajustes das medições aparecerá na tela de acordo com o par. 10: 

  

Ponte rolante: selecionar opção CRANE. 

Após selecionar os parâmetros desejados, clique em Save para gravar os ajustes. 

14.2. Seleção dos parâmetros exibidos 
Para habilitar o modo, clique no botão Show param.. 

 

  Para (des)selecionar os parâmetros a serem mostrados, duplo-clique na coluna 
Show/Hide (Mostrar/Esconder) oposta ao parâmetro desejado. Após concluir a seleção, 
clique em Save. 

14.3. Configuração dos Parâmetros L 
Para ajustar os parâmetros L-, clique em L Parameters. 
Na tabela serão mostrados apenas os parâmetros que são necessários para 

calcular os parâmetros geométricos selecionados da roda. 
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Para corrigir os parâmetros, dê duplo-clique na coluna Value oposta ao 
parâmetro desejado, e entre o novo valor na janela Data Input. Em seguida clique no 

botão Enter - . 

 
Após completar a configuração dos parâmetros, clique no botão Save para gravar.  

14.4. Valores pré-setados de parâmetros (configuração original) 
Os valores dos parâmetros L-, originais do PDA, são os da tabela abaixo: 

Parâmetro
L- 

Default value Assignment 

L1 2 mm Used for calculation of the flange slope (qR)  

L2 70 mm Defines position of the wheel rolling circle, and used for calculation: 
- flange height (sH) 
- flange thickness (sD) 
- flange slope (qR) 
- inclination angle (A) 
- wheel diameter (D) 
- rim thickness (T) 
- wear (Wt, Wf, Wr) 

L3 13 mm Used for calculation: 
- flange thickness (sD) 
- flange slope (qR) 
- wear (Wf) 

L4 13 mm An additional point for calculation of the flange slope (qR) 

L5 10 mm Used for calculation of an angular wear (Wr) 

L6 70 mm Used for calculation of slope of the rolling surface section (S1) 

L7 105 mm Used for calculation of slope of the rolling surface section (S2) 

L8 10 mm Used for measurement of the profile inclination angle at the required 
point (A) 

L9 140 mm Used for inverting the measurement direction (L9 – profile width) 

L10 599,35 mm Used for calculation of the profile diameter (D) 

L11 767 mm Used for calculation of the reference profile rim thickness (T) 

L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15) 

P7_1  
P7_2 
P8_1 
P8_2 

50 mm 
105 mm 
110 mm 
130 mm 

Used for calculation of the hollow (Hl) 

D1  
D2 

70 mm 
107,5 mm 

Used for calculation of the hollow (Hl) 

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

31 

15. Ajustando os parâmetros do banco de dados, 
tolerâncias e esquemas de medição  

A janela Settings destina-se a programar os parâmetros de banco de dados, 
tolerância, esquemas de medição, etc.  

 

Botão Função 

Database Seleção do banco de dados atual 

Reference Seleção do perfil de referência 

Scheme Configuração do esquema de medição 

Tolerance Configuração de tolerâncias 

Wheel type Seleção de tipo de roda 

15.1. Seleção do banco de dados atual 
Você pode salvar os resultados das medições no banco de dados do PDA, 

quando for necessário. O programa permite criar e gravar vários arquivos de banco de 
dados, relacionados a uma data específica de execução das medições. 

Para selecionar um arquivo de banco de dados, clique em Database. 

 

Para criar um novo banco de dados, clique no botão Add. Na tela aparecerá uma 
janela com uma outra janela para entrada do nome do novo banco de dados.  

Por padrão, será sugerida como formação do nome o formato 
wp_yy_mm_dd.ikp, onde yy_mm_dd é a data atual: 

yy   – últimos dois dígitos do ano; 
mm – mês; 
dd  – dia. 
Você pode concordar com o nome sugerido, ou entrar outro nome: 
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Em seguida clique Enter - . 

 

Para selecionar um banco de dados de uma lista previamente criado, ative a linha 
respectiva e clique Select. O arquivo selecionado será marcado com o ponto “·”. 

Para deletar o arquivo de banco de dados, ative a linha respectiva e clique 
Delete. No caso de tentar deletar o banco de dados atual, surgirá uma mensagem de 
erro. 

15.2. Seleção e instalação de perfis de referência 
O programa permite comparar o perfil escaneado da roda com o perfil de 

refrência. Para selecionar o perfil de referência, clique no botão Reference. 

 
Para selecionar o arquivo de referência, ative a linha respectiva e clique Select. 

O arquivo selecionado será marcado com o símbolo "·".  
Para deletar um arquivo de referência, ative a respectiva linha e clique Delete. 

Caso tente deletar a referência atual, uma mensagem de erro aparecerá. 
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15.2.1. Escrevendo perfil de referência no banco de dados 
Perfis de referência são armazenados no banco de dados do PDA como arquivos 

de descrução de perfil com extensão .ref. O PDA é fornecido com vários perfis pré-
instalados.  

Caso o perfil desejado não exista no banco de dados, o uduário pode solicitar o 
perfil fantante à CAPI, e então transferir o perfil recebido para o PDA conforme mostrado 
no par. 23.1.4. 

15.3. Seleção e formação do esquema de medição 
O esquema de medição é uma seqüência programada para as medições das 

rodas na oficina, com os parâmetros especificados para cada jogo de rodas (número dos 
rodeiros, número dos carros, séries, etc.). O programa automaticamente oferece ao 
operador a opção de executar uma medição em uma roda concreta de acordo com o 
esquema/seqüência selecionado. O programa contém vários esquema pré-
programados. Além disso, o usuário pode criar seus próprios esquemas de medição. 

15.3.1. Seleção ou remoção do esquema de medição 
Para selecionar o arquivo de esquema de medição, clique no botão Scheme. 

 
Para visualizar o esquema é preciso ativar a linha do arquivo do respectivo 

esquema e clicar no botão View .  

 
Setas no desenhos mostram a direção de processamento dos pares de rodas 

bem como os nomes das rodas associadas (1L-primeiro eixo, lado esquerdo; 2L-segundo 
eixo, lado esquerdo,; 1R-primeiro eixo, lado direito, etc.). 

Para selecionar o arquivo do esquema, ative sua linha e clique Select. O arquivo 
selecionado será marcado com um ponto "·".  

Para deletar um arquivo de esquema, ative sua linha e clique Delete. No caso de 
deletar o esquema atual, a mensagem de erro aparecerá. 
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15.3.2. Criação de um novo esquema de medição 
Para criar um novo quesma de medição, clique em Add. Na tela aparecerá uma 

janela para entrada do nome do novo esquema de medição.  
Usando o teclado que se abre na tela digite o nome do esquema, ou aceite o 

nome sugerido. Então, clique Enter - . Na janela aparecerão os campos para criação 
de um novo esquema. 

 
A seguir: 

 selecione o número de eixos (axles);  

 selecione o número de carros (cars); 

 selecione a seqüência de processamento dentre as opções sugeridas; 

 clique Save. 
Durante a seleção dos parâmetros Number of axles e Type of scheme você 

pode visualizar o esquema formado usando o botão View - . 
Este método de criação de esquemas só permite criar esquemas simples, sem 

especificar número de rodeiros, séries, etc. Para formar um esquema completo, veja par. 
29. 

15.3.3. Carregando um novo esquema de medição 
Você também pode criar um novo esquema de forma mais completa usando o 

programa para PC (ver par. 29), e então descarregar o esquema criado para o PDA 
conforme descrito em par. 23.1.5. 

15.4. Programação de tolerâncias  
O programa controla automaticamente se os parâmetros geométricos estão 

dentro ou fora das tolerâncias programadas. É possível criar grupos de tolerâncias. O 
controle de parâmetros será executado para um grupo selecionado.  

Para selecionar o grupo de tolerâncias a ser monitorado, clique em Tolerance. 
A tabela mostrará as tolerâncias apenas para os parâmetros geométricos da roda 

selecionados. 
A cor vermelha indica os valores críticos de máximo e mínimo para os 

parâmetros. A cor laranja indica valores de máximo e mínimo que estão próximos dos 
valores críticos. 
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Para selecionar o grupo de tolerâcias, ative a respectiva linha e clique Select. O 
arquivo selecionado será marcado com o símbolo "·".  

Para deletar uma configuração de tolerâncias, ative a respectiva linha e clique 
Delete. Ao tentar deletar o ajuste atualmente em uso, surgirá uma mensagem de erro. 

Para corrigir uma tolerâncias, ative a respectiva linha e clique Edit. 
Para adicionar uma nova tolerância, ative a linha com o nome digitado e clique 

no botão Add. Na tela aparecerá: 

 
Para mudar o nome do novo programa de tolerância é necessário acessar o 

campo Name of Tolerance com o cursor, e digitar o novo nome na tela que se abre. Em 

seguida, clique Enter - . 

A seguir, pata corrigir o valor é necessário fazer duplo-clique na coluna 
Min/Max/War.Min/War.Max diante do parâmetro desejado, e na tela que se abre entrar 
o novo valor. Então clique Enter. Se qualque parâmetro tiver valor zero, a tolerância para 
ele não será verificada/utlizada. 

Após a correção dos parâmetros de tolerâncias, clique em Save. 

15.5. Seleção e instalação de tipo de roda 
Caso vários tipos de roda sejam usados, é possível definir esquemas de 

medição, perfil de referência e parâmetros L- para cada tipo de roda.  
Por exemplo, temos 3 tipos de rodas: RodaTipo1, RodaTipo2, RodaTipo3. A cada 

novo tipo de roda que vamos medir podemos entrar com os parâmetros L-, esuqema, 
referência e tolerâncias, ou podemos definir esses valores em uma receita para serem 
usados para cada tipo de roda. Desta forma, na hora de medir basta selecionar o tipo de 
roda desejado. 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

36 

Exemplo 
 RodaTipo1: Referência 1, Esquema 1, Tolerância 1, Parâmetros L- 1; 
 RodaTipo2: Referência 2, Esquema 2, Tolerância 2, Parâmetros L- 2; 
 RodaTipo3: Referência 3, Esquema 3, Tolerância 3, Parâmetros L- 3; 

 
Para selecionar o tipo de roda, clique no botão Wheel type. 

  
Para selecionar o tipo de roda, ative a respectiva linhae clique Apply. O arquivo 

selecionado será marcado com um ponto "·".  
Para deletar o tipo de roda, ative sua linha e clique Delete. Caso tente deletar o 

tipo atualmente em uso, uma mensagem de erro aparecerá. 
Para editar o tipo de roda, ative a linha respectiva e clique Edit.  
Para adicionar um novo tipo de roda, ative a linha com o nome do tipo e clique 

em Add. Na tela aparecerá: 

 
Para mudar o nome do tipo, selecione o campo Name com o cursor, e digite o 

novo nome na tela que aparece e então clique Enter - . 
A seguir: 

 selecione o perfil de refrência (Reference); 

 selecione o esquema de medição (Scheme); 

 selecione o tipo/programa de tolerâncias (Tolerance); 

 ajuste as configurações gerais (botão Settings, ver par. 14.1.); 

 selecione os parâmetros a ser exibidos (botão Show param., ver par. 14.2.); 

 ajuste os parâmetris L- (botão L Parameters, ver par. 14.3.); 

 clique Save. 
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16. Atualizando o software do PDA software 
A versão do software aparece no menu principal. Na tela: 

 
 
O procedimento para atualização do software do PDA é descrito no par. 20.1.5. 

deste manual. 

17. Desligar 

Para desligar o PDA, clique no botão Shutdown - .  
 

 
 

18. Medições com manutenção de banco de dados 
Há dois modos de medição: 
1. Medições Rápidas sem o registro dos resultados. 
2. Medições usando o esquema selecionado e salvando os resultados no banco 

de dados. 
Procedimento para medições rápidas está descrito no par. 12. Como selecionar 

o tipo de medição, ver par. 12.2.  
O segundo tipo é usado para um trabalho totalmente funcional com o 

perfilômetro, com a manutenção de um banco de dados das medições.  
Quando a conexão Bluetooth é estabelecida, você pode passar para as medições 

clicando o botão Measurement na janela do menu principal. A janela para entrada dos 
parâmetros dos rodeiros aparecerá na tela: 
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Os campos dos parâmetros serão automaticamente preenchidos de acordo com 
o esquema de medição selecionado. Se necessário, você pode editar/preencher os 
campos disponpiveis, e então clicar Save para gravar as alterações. O esquema 
selecionado será exibido na tela: 

 
Designações e botões: 

 
número (ordem) do carro a ser medido  
(número total de carros na composição) 

 

edição dos parâmetros da roda selecionada 

 
passar para a roda seguinte/anterior  

 
passar para o carro seguinte/anterior 

 
roda já medida  

 
próxima roda a ser medida 

 
roda ainda não medida  

 
roda já medida, que necessita ser medida novamente  

 

botão para executar a medição da roda sinalizada em verde 
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18.1. Medição 
 

 Meça a roda sugerida pelo programa (destacada em verde). Para isso, clique 
Measure. O módulo laser escaneará a superfície da roda.  

 Ao completar o processo de escaneamento os valores de parâmetros 
geométricos medidos, selecionados para serem exibidos, aparecerão na tela 
do PDA.   

 

Valores medidos além das tolerâncias, serão destacados em vermelho: 

 

É possível também visualizar apenas os paRâmetros do perfil medido. para 
esconder os valores de referência, des-selecione a caixa Reference. 
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 Para ver o perfil da roda, clique o botão View- . O perfil da roda escaneada 
e da referência selecionada serão exibidos na tela do PDA.  

 

 Para mais informação sobre o trabalho com os perfis veja par. 20.2. 

 Para executar a medição novamente clique no botão Measure.  

 Quando um resultado satisfatório é obtido, clique em Save para gravar. 

 O programa então sugerirá passar para a medição da próxima roda de acordo 
com o esquema de medição selecionado. 

 

 Para ver os resultados das medições anteriores, use as setas. Se você 
selecionar uma roda já medida, os parâmetros gravados serão exibidos na tela 
do PDA.  
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 Quando você mede novamente uma roda que já havia sido medida, o programa 
pergunta se você deseja substituir a medição anterior pela nova. 
 

 
 

18.2. Medição de desgaste regular / irregular (even/uneven wear) 
A medição do desgaste (ir)regular é um pouco diferente de uma medição padrão. 

Para obter o resultado do desgaste, é preciso executar diversas medições em diferentes 
pontos da roda. Ao passar à janela de medição, um botão adicional Apply aparecerá na 
tela. 

 

Após cada medição, para salvar os valores atuais de desgaste você deve clicar 
em Apply. Nas medições subsequentes, o programa irá automaticamente encontrar o 
desgaste máximo e mínimo da roda e calcular o desgaste regular/irregular. 

 

Quando um resultado satisfatório for obtido, clique no botão Save para gravar. 
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18.3. Medição de defeitos 
IKP permite medir defeitos nas rodas. 

 Slide size (sP) 

 Cavity size (hR) 

 Cavity area (sR) 
A medição de defeitos é diferente da medição normal. 
O procedimento para medição de declives e cavidades é descrito abaixo:  

 Execute uma medição em um ponto do perfil que não apresente defeitos 
aparentes (declives, cavidades).  

 

 Se a medição resultou satisfatória, clique no botão Apply. Os campos com 
opção de ativação Slide e Cavity surgirão na tela.  

 

 Selecione o defeito que deseja medir (deixar ticado o respectivo quado).  

 Posicione o perfilômetro adequadamente (o laser deve passar pelo defeito a 
ser medido). 

 Clique o botão Measure para iniciar a medição.  
Ao completar a medição, o programa calcula o valor do parâmetro selecionado. 
Uma vez obtido o resultado, clique Save para gravar no banco de dados. 

19. Medindo com MPRC, MBRC, MDRC, e salvando 
no banco de dados 

O uso do PDA com outros dispositivos é descrito nos respectivos manuais do 
usuário. 

Muitas vezes é necessário que os resultados de medições, obtidas de diferentes 
dispositivos, sejam gravados em um mesmo banco de dados. Neste caso, todos os 
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parâmetros do respectivo jogo de rodas, devem ser os mesmos em todos os 
instrumentos de medição.  

Estes campos são: 

 Date 

 N wheelset 

 Series  

 Number 

 Axle  

 Side (besides IMR)  

 

20. Buscando no banco de dados 
Para procurar os dados salvos, clique no botão Profiles no menu principal. Na 

tela serão mostradas informações sobre o banco de dados atual, quantidade de perfis 
salvos, tabela com perfis salvos, e valores medidos dos parâmetros selecionados. 

 

Botões: 

 
Passa para a navegação/visualização do perfil da roda selecionada  

 
Deleta a roda selecionada  

 
Adiciona um filtro à busca do banco de dados  
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Deleta um filtro  

 
Salva o arquivo de referência  

20.1. Filtragem de dados 
Para adicionar um filtro, clique no botão Filter, e ajuste os parâmetros de 

filtragem na tela que aparece. 
Um exemplo de filtragem pelo parâmetro Eixo (Axle): 

 

O campo filtrado será destacado em amarelo:  

 
 

Para deletar o filtro atual, clique em .  

20.2. Visualização do perfil da roda 

Para navegar no perfil da roda, clieuqe no botão Profile - . O perfil de roda 
escaneado e o perfil de referência selecionado serão mostrados na tela do PDA.  
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Botões de navegação para visualização de Perfis: 

 
Zoom in  

 
Zoom out 

 
Zoom Padrão (Standard image scale ) 

 
Visualiza perfil de desgaste (Browse the profile wear ) 

Abaixo um exemplo de imagem com zoom: 

 
 
Abaixo exemplo de visualização de desgaste. Um desgaste positivo é destacado 

em verde, desgaste negativo é aparece em azul. 

 

21. Instalação e inicialização do software no PC 

21.1. Instalação do software de suporte de banco de dados 
O siftware ikp5_DB serve para manutenção do banco de dados de desgaste de 

rodas em um PC (a versão atualizada do programa pode ser solicutada pelo e-mail 
capi@capicontrole.com.br).  

Para instalar o software, insira o pendrive no drive do PC, selecione-o e execute 
Install_Ikp5.exe que está na pasta Software. Siga as orientações do guia que aparecem 
na tela. O programa é instalado na pasta C:\Program Files (x86)\Riftek, LLC\Ikp5_db\. 
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21.2. Sincronização do PDA com o PC 
Há dois modos de sincronização via cabo USB cable para transferência de dados 

entre o PDA e o PC:   

 MS ActiveSync 

 Mass Storage  
Quando selecionado MS ActiveSync, a sincronização será feita pelo software 

ActiveSync (Windows XP), ou via Windows Mobile Device Center (Windows 7), que 
precisa ser instalado no PC. Os arquivos de instalação estão disponiveis no CD 
fornecido. 

Nos parâmetros do PDA deve ser selecionado o modo de sincronização 
ActiveSync (ver par. 13.6.). 

 

Quando você escolhe o modo Mass Storage, o dispositivo será detectado no 
Windows como um dispositivo de armazenamento externo. 

Neste caso, no PDA deve ser selecionado como modo de sincronização o  Mass 
Storage (ver par. 13.6.). 

Para verificar se a sincronização está correta via ActiveSync, ligue o PDA e 
conecte-o à porta USB do PC com o cabo. Se a conexão foi concluída com sucesso, 
uma mensagem aparecerá na tela: 

 

21.3. Iniciando o Programa 
Para iniciar o programa, clique Start > All programs > Riftek, LLC > IKP5_DB 

> Ikp5_DB.exe. Visualização da tela principal do programa é mostrada abaixo. 

http://www.capicontrole.com.br/


PERFILÔMETRO DE RODAS A LASER 

 
www.capicontrole.com.br – (19) 3604.7068 / 3468.1791  MPRC [Revision 4.0.0] 04.05.2023 

47 

 

22. Ajustes do usuário  

22.1. Ajuste de parâmetros (Parameters setting) 
Para acessar a janela de ajuste de parâmetros, clique Settings > Parameters na 

tela principal ou clique . 

 
 
A janela settings inclui 4 abas: 

 Parâmetros das Rodas (Wheelset's parameters) 

 Parâmetros Calculados (Calculated parameters) 

 Parâmetros L (L parameters) 

 Método de medição 

22.1.1. Aba Parâmetros das Rodas ("Wheelset's parameters") 
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Nesta aba você pdoe selecionar oa parâmetros que serão mostrados na tela ao 
visualizar o banco de dados. 

 
Se o parâmetro está “ticado”, seu valor será mostrado na tabela de resultados e 

na tabela de perfis.  

22.1.2. Aba Parâmetros Calculados "Calculated parameters" 
Nesta aba o usuário pode selecionar os parâmetros geométricos que serão 

calculados e mostrados na tela quando visualizar o banco de dados. 

 
Descrições e funções dos parâmetros são as mesmas do software do PDA (ver 

par. 10.). 

22.1.3. Aba Parâmetros L ("L parameters") 
Nesta aba o usuário pode selecionar os valores dos pontos de suporte para os 

parâmetros geométricos calculados. 

 
Descrições e funções destes pontos são as mesmas do software do PDA (ver 

par. 10.). 

22.1.4. Aba Método de Medição ("Measurement method") 
Nesta aba é possível especificar o método de cálculo dos parâmetros 

geométricos. 
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Descrições e funções dos métodos de medição são as mesmas do software do 

PDA (ver par.10.). 

22.1.4.1. Seleção das unidades de medida 
Todos os parâmetros e resultados de medição podem ser exibidos no sistema 

métrico (milímetros), ou no sistema inglês (polegadas).  
Para ajustar estas unidades de medida, selecione mm ou inches no campo 

Units of measurement. Após salvar as alterações, toda a informação será mostrada na 
unidade escolhida.  

22.2. Ajustes de banco de dados (Database settings) 

22.2.1. Selecionando caminho do banco de dados 
O programa permite alterar o drive e diretório de armazenamento do banco de 

dados de perfis. Para fazê-lo, selecione File > Path to DB... na janela principal. 

 
A seguir: 

 clique no botão Select  

 especifique o novo caminho para o banco de dados 

 confirme a criação de um novo banco de dados  
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Após fazer isso, todos os arquivos de banco de dados serão copiados para o 

caminho especificado.  

 

22.2.2. Criação de um banco de dados vazio 
Para criar um banco de dados vazio, selecione File>New DB no menu principal. 

 
Todos os dados, exceto arquivos de referência, serão deletados do banco de 

dados. Ao mesmo tempo, um backup DB(dd.mm.yy) será criado no diretório de 

instalação, para o qual todos os dados excluídos serão copiados (dd.mm.yy – data 

atual). Subsequentemente, estes dados poderão ser recuperados (ver par. 22.2.3). 

22.2.3. Importação de banco de dados   
Para importar dados para um banco de dados a partir de outro banco de dados 

(previamente salvo): 
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 Selecione File > Import Data no menu. 

 Selecione a pasta com os arquivos DB na janela à esquerda. Todos os arquivos 
aparecerão na janela direita: 

 
 Clique OK para importar os dados. 

22.2.4. Seleção de idioma 
Para escolher o idioma do software, selecione Settings > Language no menu 

principal e escolha o arquivo de suporte desejado. 

 

22.2.4.1. Preparação e instalação do arquivo de suporte a idioma 
O usuário pode mudar o idioma, a partir de seus próprios arquivos de suporte, 

bem como mudar/editar a terminologia usada. Os arquivos de suporte estão no diretório 
usado no processo de instalação. Por padrão, o seguinte diretório é usado: C:\Program 
Files (x86)\Riftek, LLC\Ikp5_db\Language\.  

O diretório contém dois arquivos, RUS.lng e ENG.lng, para os idiomas Russo e 
Inglês respectivamente.  

Para criar o arquivo de suporte para qualquer outra língua é preciso:  

 copiar um dos arquivos existentes. Por exemplo, ENG.lng com outro nome, por 
ex. POR.lng;  

 editar o arquivo renomeado usando qualquer processador de textos, e alterar 
os termos e frases por equivalentes no idioma desejado; 

 salvar o arquivo editado *.lng na pasta Language. 
Para mudar e editar aterminologia, é preciso: 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

52 

 editar o arquivo de idioma correspondente usando um processador de textos; 

 salvar o arquivo *.lng editado na pasta Language. 

22.3. Dados de Registro 

22.3.1. Seleção da organização 
Para adicionar/selecionar a organização do usuário, selecione no menu principal 

Registration > Organization. Futuramente, esta informação será usada para obtenção 
dos dados da oficina/estação/organização selecionada e para a geração de relatórios. 
 

 
 

Funções dos botões: 

 
Adiciona uma nova organização 

 
Deleta a organização selecionada 

 
Edita a organização selecionada 

 
Sai do modo de registro de organização  

Para selecionar uma organização atual: 

 Clique Edit 

 Tique a estação escolhida 

 Clique Save 

 

22.3.2. Registro de operadores 
Passos a seguir: menu Registration > Operator. O cadastro de operadores é 

usado para identificá-los por um Número. 
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 Funções dos botões são similares às descritas no par. 22.3.1. 

22.3.3. Registro de séries 
Passos a seguir: menu Registration > Series. Séries de carros ou locomotivas 

registradas surgirão na tela.   

 
Ao registrar uma nova série, uma nova entrada para esta série será adicionada 

à tabela de tolerâncias automaticamente (ver par. 22.3.5). 
Funções dos botões são similares às descritas no par. 22.3.1. 
Ao adicionar uma nova série é preciso escolher um nome e selecionar o perfil de 

refertência para ela. Os parâmetros de flange do perfil selecionado serão calculados e 
adicionados à tabela de tolerâncias automaticamente após as séries serem salvas (ver 
cap. 22.3.6). 

22.3.4. Registro dos números do carro/locomotiva 
Passos a seguir: menu Registration > Number. Os números de 

carrps/locomotivas registrados surgirão na tela.   

 
Funções dos botões são similares às descritas no cap. 22.3.1. 
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22.3.5. Registo de tolerâncias 
Passos a seguir: menu Registration >Tolerance. As séries registradas de 

carros/locomotivas com os valores de contorno dos parâmetros geométricos calculados 

dos rodeiras aparecerão na tela.  

 
Apenas os parâmetros selecionados na lista de parâmetros estarão disponíveis 

para edição (ver cap. 22.1.2.).  
Valores críticos de Máximp/mínimo dos parâmetros são indicados na cor 

vermelha. A cor laranja indica valores de máximo/mínimo dos parâmetros que estão 
próximos ao crítico (“pré-tolerância”). 

O valor de Norma é calculado e adicionado à tabela automaticamente ao 
adicionar/editar as séries da referência selecionada (ver cap. 22.3.3). 

22.3.6. Registro de perfis de referência 
O programa é fornecido com vários perdis pré-programados. Adicionalmente, o 

CD com o software contém a base dos perfis de referência. Os perfis estão no diretório 
Reference Profiles e divididos em pastas separadas para cada país. 

O usuário também pode criar seu próprio perfil de referência ou solicitá-lo à 
CAPI/RIFTEK.  

Para navegar entre os perfis disponívies, selecione menu Registration > 
Reference: 
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A janela de perfis exibe a tabela com a lista de perfis de referência, salva no 

banco de dados e uma visualização gráfica do perfil selecionado. 

 

 

 

Funções dos botões: 

 
Deleta o perfil de referência  

 
Importa o perfil de referênciado arquivo *.ref  

 
Exporta o perfil de referência para o arquivo *.ref  

 
Sai do modo de registrro de organização  
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22.3.6.1. Requisição e registro do arquivo de perfil 
Para obter o arquivo .ref envie o desenho do perfil para a CAPI 

(capi@capicontrole.com.br). Registre o arquivo .ref recebido conforme abaixo: 

 clique Import 

 na janela que se abre, indique o caminho para o arquivo .ref 

 clique Open 
O perfil será adicionado à base de perfis de referência. 

23. Troca de dados entre PDA e PC  
Para trocar dados entre PC e PDA selecione o dispositivo: File > Device > 

RF303M-PDA.  

 
Os dados são trocados com a conexão direta via cabo entre o PDA e a porta USB 

do PC (o cabo especial RF505.42 para isso é fornecido com o equipamento).   
Há duas formas de sincronuzação via cabo USB: 

 ActiveSync 

 Mass Storage  
Para mais detalhes veja cap. 21.2.  

23.1. Sincronização ActiveSync  
Quando este modo de sincronização é selecionado, funções adicionais de troca 

de dados com o PDA são disponibilizadas: 

 Transferência de arquivos de banco de dados para o PC 

 Transferência de arquivos de linguagem (idiomas) 

  Transferência de arquivos de perfis de referência  

 Transferência de arquivos de esquemas de processamento 

 Atualização do software do PDA 

23.1.1. Transferir arquivo de banco de dados para o PC  
Para transferir o arquivo de banco de dados do PDA para o PC, é preciso: 

 selecionar PDA > Import Data 
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 marcar os arquivos desejados na janela que se abre e clicar OK  

 

23.1.2. Transferir arquivo de idioma do PC para PDA 
Para transferir o arquivo de idioma do PC para o PDA, é preciso: 

 selecionar PDA > Language file > Export 

 
 selecionar o arquivo desejado 
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Se a transferência foi feita com sucesso, a janela mostrará: 

 

23.1.3. Transferência de arquivo de idioma do PDA para o PC 
Para transferir o arquivo de idioma do PDA para o PC: 

 selecione PDA > Language file > Import 

 
 selecionar o arquivo desejado 
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Se a transferência foi concluída, os arquivos selecionados serão salvos no 
diretório especificado. 

23.1.4. Transferência do arquivo de perfil de referência do PC para o PDA  
Para trnsferir o arquivo de referência de perfil do PC para o PDA: 

 selecione PDA > Reference file > Export 

 

 selecione o arquivo .ref desejado 
Uma mensagem na tela indicará se a transferência foi concluída com sucesso: 

 

23.1.5. Transferência do arquivo de esquema do PC para o PDA  
Para transferir o arquivo de processamento de esquema do PC para o PDA: 

 selecione PDA > Scheme file > Export 
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 selecione o arquivo .sch desejado 
Uma mensagem na tela indicará se a transferência foi concluída com sucesso: 

 

23.1.6. Atualizando o software do PDA 
A versão atualizada do software pode ser solicitada à CAPI Controle ou baixada 

do site www.riftek.com/resource/files/ikp5_pda.zip. Para transferir o arquivo de update 
para o PDA: 

 selecione PDA > PDA update  

 
 selecione o arquivo a ser transferido 
Uma mensagem na tela indicará se a transferência foi concluída com sucesso: 
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23.2. Sincronização Armazenamento de Massa  
Quando este modo de sincronização é selecionado, o PDA é visto como um 

dispositivo de armazenamento externo (“pen drive”). Portanto, apenas a função Import 
Data fica ativa no software. Transferência de arquivos de idioma/esquema/referência do 
PDA para o PC e vice-versa podem ser feitas simplesmente copiando os arquivos. 

 
Para transferir arquivos de banco de dados do PDA para o PC, é preciso: 

 selecionar PDA > Import Data 

 especificar o caminho do arquivo no PDA (por default, SDMMC\Autorun\DB) 

 
 marcar os arquivos desejados na janela que se abre e clicar OK  
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24. Trabalhando com perfis e cálculos de desgaste 

24.1. Buscando o gráfico e as coordenadas do perfil 
Para pesquisar os perfis salvos, selecione Database > Profiles, ou clique no 

botçao Profiles - . 

 

No lado esquerdo da janela, está a aba Table of profiles, que contém uma lista 
dos perfis salvo. A tabela mostra apenas os parâmetros de indentificação da roda, que 
foram selecionados na janela de parâmetros (ver cap. 22.1.). 

Ao selecionar um perfil, é possível ver seu gráfico e os parâmetros geométricos 
da roda medida. Para buscar as coordinadas do perfil selecionado,. clique o botão Profile 
Values. Uma aba adicional com as coordenadas medidas aparecerá. 
Funções dos botões: 

 Mostra/esconde gráfico de Desgaste 

 Mostra/esconde aba dos Valores do Perfil 

 Mostra/esconde aba alinhamento do perfil  

 Salva a imagem do perfil para um arquivo (.bmp) 

 Imprime a imagem do perfil  

 Muda a cor de fundo do gráfico  

 Zoom in/out no gráfico 

 Calcula os parâmetros geométricos da roda  
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24.2. Aba Parâmetros 
Os parâmetros geométricos calculados e parâmetros L-são mostrados na aba 

Parameters, no rodapé da janela. 

 
Se necessário, é possível alterar os ajustes dos parâmetros calculados ou pontos 

de suporte (ver cap. 22.1). 

24.2.1. Seleção do perfil de comparação 
Para comparar um perfil com uma referência, habilite o campo Compare. Há 

duas formas de fazer a comparação: 

 com a referência 

 com um outro perfil medido 
Quando for comparar com uma referência, selecione o perfil desejado entre os 
modelos na lista. 

 
Para comprara dois perfis medidos entre eles (por exemplo, da roda esquerda e 

direita), selecione no campo de comparação a opção Measured. A aba Table of profiles 
mostrará uma tabela adicional dos perfis medidos, permitindo a seleção de um deles 
para a comparação.  

24.2.2. Seleção dos valores de parâmetros L- 
Ao calcular os parâmetros geométricos, os pontos de suporte especificados 

serão usados (ver cap. 22.1.3). Há duas opções possíveis para os parâmetros  L-: 

 Parâmetros Gerais 

 Parâmetros de Perfil 
Ao selecionar General parameters, os valores serão tirados do arquivo de banco 

de dados de parâmetros selecionado como default (ver 22.1.3). 
Ao selecionar Profile parameters, os valores serão tirados do arquivo de banco 

de dados de perfil salvo, i.e. os valores programados no PDA no momento da medição 
das rodas (ver cap. 14.3.). 

Os valores dos parâmetros L- são mostrados na tela, na tabela de parâmetros. 
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Se necessário, é possível editar qualquer valor e recalcular os valores dos 
parâmetros geométricos do friso. Para fazê-lo, clique Calculate. Os parâmetros do perdil 
medido e da referência selecionada serão recalculados.  

24.2.3. Parâmetros geométricos do perfil 
A tabela dos parâmetros geométricos mostra apenas os parâmetros que foram 

selecionados na janela parâmetros (ver cap. 22.1.2). 

 
Parâmetros fora das tolerâncias programadas, são destacados em 

vermelho/laranja (ver cap. 22.3.5). 

24.3. Cálculo de desgaste 

24.3.1. Cálculo rápido de desgaste 

Para obter um cálculo rápido do desgaste do perfil em um certo ponto em relação 

à referência, posicione o cursor em um dos perfis, e quando um cursor em forma de cruz 

(+) aparecer, clique com o botão esquerdo do mouse. A tela resultante mostrará o valor 

das diferenças de coordenadas entre os perfis ao longo dos eixos X- e Y-, como mostrado 

pelas setas: 

 

Para remover a indicação da tela, posicione o cursor em um dos perfis e 

pressione o botão direito do mouse. 

24.3.2. Cálculo de desgaste em todos os pontos 
Para calcular o desgaste em todos os pontos do perfil medido, clique no botão 

Wear. O desgaste calculado será mostrado na tela de forma gráfica: 
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O gráfico mostra valores positivos e negativos de desgaste. O valor da área de 

desgaste é calculado em mm² em relação ao perfil de referência selecionado: 

 

Para ver a tabela dos valores de desgaste, selecione Profile Values > Wear. A 
tabela mostrará os desvios do perfil selecionado em relação à referência nos dois eixos 
(X e Y). 

 

Para salvar a tabela em formato Excel, é preciso clicar com o botão direito do 
mouse na seção da tabela de valores . Uma janela pop-up aparecerá: 

 Edit 

 Save to the file 
Ao selecionar Edit, a janela de edição abrirá, e nela você pode ediatr os valores 

e salvá-los no formato .xls. 
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Para salvar, é preciso: 

 selecionar File > Save 

 selecionar Excel 5 (*.xls) 

 digitar o nome do arquico e clicar Save 

 

 

  Ao selecionar Save to the file, abre uma janela de diálogo para salvar o arquivo.  

24.4. Alinhamento de Perfis 
Para sobrepor perfis (por translação vertical), clique no botão Alignment. Uma 

aba adicional aparecerá. S seguir, selecione o perfil a ser transladado: Reference ou 
Measured. O perfil selecionado aparecerá em vermelho.  

    
Após selecionar o perfil a tela mostrará os desvios mínimos e máximos entre o 

perfil selecionado e a referência [Min dY..Max dY]. 
A seguir, ajuste o passo de translação e usando os botões de seta Sobe/Desce, 

Esquerda/Direita mova o perfil conforme desejado.  
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Para salvar o perfil alterado, passe à aba de identificação de parâmetros, pass 
do perfil e clique Save.  

 
Para criar um novo perfil, é preciso mudar seus parâmetros de identificação. 

24.5. Sobreposição de Perfis 
Para sobrepor vários perfis alterados, selecione os perdis requeridos na tabela à 

esquerda. Os perfis selecionados serão mostrados em diferentes cores.  

 
 

24.6. Escala (zoom) 
Para mudar a escala, marque um quadrado sobre a área a ser ampliada 

segurando o botão direito do mouse pressionado, ou use os botões Increase -  

, Decrease -   e Show all - . 
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25. Implementação da função de torneamento mínimo 
Selecione Tools > Analysis of profiles. A análise dos perfis das rodas direita e 

esquerda permitem escolher um tipo de perfil entre os perfis de referência, para o qual a 
profundidade de usinagem do par de rodas seja mínima. 

Na primeira tabela, selecione o primeiro perfil desejadodo jogo de rodas (roda 
esquerda); na segunda tabela, escolha o segundo perfil desejado (roda direita). 

O programa permite uma análise automática entre todos os perfis disponíveis 
armazenados no banco de dados, ou apenas pelo perfil selecionado. 

 Análise automática 
Para a análise autompatica de perfis, selecione a caixa próxima ao botão 

Analysis e clique neste botão. Os perfis na tabela de referências não devem ser 
marcados. 

 
Para obter o valor do torneamento mínimo no ponto da banda de 

rodagem, o cálculo será feito considerando todas as referências. 

 Análise pelo perfil selecionado  
Para a análise de perfis, é necessário selecionar o perfil de referência, 

através do qual se deseja analisar, e clicar no botão Analysis. O cálculo será 
feito e o valor mínimo de tornamento no ponto da banda de rodagemserá obtido 
para o perfil selecionado. 
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Para saber a profundidade de usinagem em um certo ponto, posicione o cursor 
sobre o perfil, e quando um cursos em forma de cruz (+) aparecer, pressione o botão 
esquerdo do mouse. A tela resultante mostrará o valor da diferença entre os perfis nos 
eixos X- e Y-, como mostram as setas. Para remover esta indicação da tela, coloque o 
cursos em qualquer perfil e pressione o botão direito do mouse. 

26. Buscando e editando dados 

26.1. Pesquisando e filtrando dados 
Para pesquisar dados, selecione Database > Table no menu ou clique no 

botãoTable - . O formato com resultados será como abaixo: 
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 Mostrar/esconder campo 
A tabela mostra a identificação e os parâmetros geométricos das rodas, 
que estão marcados para exibição nos ajustes de parâmetros (ver cap. 
22.1.1 e  22.1.2). 

 Ordenação de dados 
Para ordenar os dados por qualquer um dos campos, clique com o botão 

esquerdo no cabeçalho da coluna do campo desejado: 

 

 
 

 

 
Para cancelar a ordenação, pressione a tecla Ctrl e clique com o botão da 

esquerda do mouse no cabeçalho da coluna deste campo. 

 Filtragem de dados  
Para filtrar os dados em qualquer campo, clique com o botão esquerdo na seta à 

direita no cabeçalho da coluna, e selecione o valor requerido na lista que se abre: 

 

 
 
 

 

 
 

Para cancelar o filtro, retire a seleção do filtro aplicado. 

 Data grouping 
To group data for any of the fields, click left mouse key on the header of the field 

column, and, with the mouse key pressed, drag it onto the table header: 

 

 
 
 

 

 

 Mudando a posição / ordem dos campos  
Para mudar a posição de cada campo, clique com o botão esquerdo no cabeçalho 

do campo desejado e, mantendo o botão pressionado, arraste o campo para a posição 
desejada: 
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Funções dos botões: 

 Adiciona o par de rodas  

 Deleta o par de rodas selecionado 

 Deleta todos os pares de rodas 

 Edita o par de rodas selecionado 

 Exporta as coordenadas dos pares de rodas para o formato Excel 

 Gera relatório 

26.2. Edição de dados 
Você pode editar, adicionar e remover dados do banco de dados. 

 Editando dados 

Para editar a entrada atual, clique no botão  e entre/altere os valores 
desejados dos parâmetros. Após terminar, clique o botão Save. 

 
 Adicionando dados 
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Para adicionar uma nova entrada de dados, clique  e digite os 
parâmetros necessários. Após conlcluir a edição. clique Save. 

 
 Deletando dados 

Para deletar a entrada atual, clique  e confirme. 

 
 Deletando todos os dados selecionados 

Caso seja necessário deletar várias entradas de dados combinadas por alguma 
condição, filtre os dados de acordo com o atributo desejado (ver cap. 26.1.),  clicar o 

botão  e confirmar. 

 

26.3. Geração de Relatórios 
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Quando estiver visualizando os dados, o usuário pode gerar relatórios nos 
formatos Excel, RTF, PDF ou imprimir relatórios. Ao preparar o relatório, a ordenação 
useda na tela naquele momento é utilizada.   

Para gerar um relatório, pressione o botão . O programa oferecerá 
as seguintes opções: 

 

26.3.1. Relatório em Excel 
Para preparar um relatório em Excel, selecione Report in Excel e clique ОК. 

Após a escolha do nome do arquivo, todos os dados mostrados serão transferidos para 
uma planilha Excel: 

 

26.3.2. Relatório para impressão 
Para preparar um relatório para impressão, selecione Report for printout e 

clique ОК. Os dados serão apresentados na forma de relatório pronto para impressão.  
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A barra de ferramentas superior contém os seguintes botões para trabalhar com 

relatórios:  

 Para imprimir, clique  . 

 Para salvar em .pdf, clique  . 

 Para salvar em Excel, RTF ou PDF, clique  e selecione o formato desejado: 

 

27. Fazendo medições via PC (sem PDA) 
O módulo laser (RF505) pode trabalhar diretamente controlado por um PC, sem 

o PDA. Para trabalhar desta forma, selecione File > Device > RF505-Profilometer no 
menu principal. 
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Em seguida, no menu principal do programa o PDA será substituído pelo item  
Profilometer. 

 
O menu contém dois itens disponíveis: 

 Calibration  

 Measurement  
Antes de começar a trabalhar com o perfilômetro, é preciso selecionar a porta 

COM- ou conexão Bluetooth entre o módulo scanner laser e o PDA. O procedimento é 
descrito no manual do adaptador Bluetooth. 

27.1. Calibração 

Para calibração, selecione Profilometer > Calibration, ou clique .  

 

27.1.1. Instalação da conexão Bluetooth 

Para conectar, selecione a porta COM- e clique o botão Connect. 

 
Se a conexão foi bem sucedida, o dispositivo será identificado e os parâmetros 

de calibração serão obtidos. O status mudará para Connected.   

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

76 

 
A tabela dos parâmetros de calibração:  

 
Botões: 

 Medição 

 Lê parâmetros de calibração 

 Escreve parâmetros de calibração 

 Ajuste automático dos parâmetros de calibração 

 

 

O botão Auto calibration ficará ativo, se pelo menos uma medição do 
perfil tiver sido executada, bem como se o perfil de referência estiver 
selecionado 

27.1.2. Calibração do Perfilômetro 
 Posicione o perfilômetro no bloco de calibração.   

 Selecione o perfil de referência na lista (Compare > Reference).  

 Execute a medição (botão Measurement) 

 Execute a calibração (botão Auto calibration) 

 Salve os parâmetros de calibração (botão Write param.). 
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Parâmetros de calibração podem ser ajustados manualmente. Para isso, 

clique com o botão esquerdo do mouse no campo do parâmetro desejado e digite 
um novo valor. 

 

Atenção! Escrever parâmetros incorretos de calibração pode resultar em 
funcionamento incorreto. Em caso de dúvidas, consultar ou enviar o medidor 
para aferição ao distribuidor autorizado no Brasil, CAPI Controle.  

Funções dos botões, como trabalhar com os perfis e cálculo dos 
parâmetros requeridos estão descritos no cap. 22. 

27.2. Medição usando PC 

Para medir, selecione Profilometer > Measurement, ou clique .  

 
Após estabelecer a conexão Bluetooth (ver cap. 27.1.1), o botão 

Measurement ficará ativo. 
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27.2.1. Salvando os dados 
 Posicione o perfilômetro na roda 

 Execute a medição (botão Measurement)  

 Entre os parâmetros de identificação da roda 

 
 Para salvar os resultados, clique Save  

 O perfil medido será salvo no banco de dados 
Funções dos botões, como trabalhar com os perfis e cálculo dos 

parâmetros requeridos estão descritos no cap. 22. 

28. Anexo 1: Procedimento de recarga 
 Desligue o PDA (módulo laser).  

 Conecte o carregado ao o PDA (módulo laser). 

 Conecte a fonte do carregador (127/220V). 

 Tempo de carga – 4 horas, até que o LED azul de acenda. 

 Desconecte a fonte e da tomada. 

 Desconect e o carregador do PDA (módulo laser)  

 Atenção! Obedecer esta seqüência!  

29. Anexo 2: Programa para criação de esquemas de 
medição 

 

Para criar esquemas de medição, o usuário pode usar o software especial 
SchemeBuilder.exe. Ao iniciar, a janela principal aparece na tela: 
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Para criar um esquema:  

 Entre o número de carros/vagões    

 Entre o número de eixos em cada carro   

 Se a medição é feita em ordem reversa, selecione a caixa  

 Selecione o tipo do esquema  

 Clique no botão para aceitar  

 A seguir entre os parâmetros de todos os rodeiros em seqüência para cada 
carro: 

 
 Os campos Axle (eixo) e Car (carro) são usados para navegar pelo esquema  

 
 Clique o botão Save scheme  

 Entre o nome do esquema na caixa de diálogo: 

 

http://www.capicontrole.com.br/


LASER WHEEL PROFILOMETER, Série MPRC,  

 

 
MPRC CAPI - www.capicontrole.com.br – (19) 3604.7068 
    

80 

O programa permite editar o esquema existente. Para isso, clique no botão Load 
scheme e selecione o arquivo *.SCH. Após carregar, você pode editar e salvar os 
parâmetros dos rodeiros. 

Para transferir o arquivo de esquema para o PDA, use o procedimento descrito 
no cap. 23.1.5. 
 

Esclarecimento. O esquema de medição é um arquivo de texto com extensão 
.sch. O usuário também pode criar e editar este arquivo usando qualquer processador 
de textos.  

Exemplo: 

 
 
Scheme_EXAMPLE  
{  
1d-|SM3|7102|1l|11|SU11|111|1r|11|SU11|111|2l|12|SU12|112|2r|12|SU12|112|3l|13|SU13|113|3r|13|SU13|113|4l|14|SU14|114|4r|14|SU14|114|;  
2d-|SM3|7202|1l|21|SU21|211|1r|21|SU21|211|2l|22|SU22|212|2r|22|SU22|212|3l|23|SU23|213|3r|23|SU23|213|4l|24|SU24|214|4r|24|SU24|214|;  
3d-|SM3|7302|1l|31|SU31|311|1r|31|SU31|311|2l|32|SU32|312|2r|32|SU32|312|3l|33|SU33|313|3r|33|SU33|313|4l|34|SU34|314|4r|34|SU34|314|;  
4i-|SM3|7402|4r|44|SU044|414|4l|44|SU44|414|3r|43|SU43|413|3l|43|SU43|413|2r|42|SU42|412|2l|42|SU42|412|1r|41|SU41|411|1l|41|SU41|411|;  
5i-|SM3|7502|4r|54|SU54|514|4l|54|SU54|514|3r|53|SU53|513|3l|53|SU53|513|2r|52|SU52|512|2l|52|SU52|512|1r|51|SU51|511|1l|51|SU51|511|;  
6i-|SM3|7602|4r|64|SU064|614|4l|64|SU64|614|3r|63|SU63|613|3l|63|SU63|613|2r|62|SU62|612|2l|62|SU62|612|1r|61|SU61|611|1l|61|SU61|611|;  
}  
Where: 
1d – coaches arranged in direct order (1 – sequence number)  
1i – coached arranged in the reverse order (1 – sequence order) 
SM3 – coach series  
7102 -number 
1l – sequence number of wheel pair and the side (l- left/r-right)  
11 – axle number  
SU11 – name of wheel set  
111 – running distance of wheel set 

 

30. Anexo 3: Teste e calibração 

Testing and calibratio 
A CAPI dispõe de laboratório para teste e calibração dos medidores. Entretanto, podemos 

fornecer opcionalmente o perfilômetro completo, com um bloco padrão RF432.10 de simulação 

de roda (adicione BP a seu pedido) (Fig. 1A) e o software de calibração RF505Calibr 

desenvolvido para testes periódicos e calibraçaõ do perfilômetro. 

Ao invés do bloco padrão, pode também ser usada uma roda com perfil conhecido devidamente 

programado no banco de dados (ver cap. 22.3.6). 

Antes de iniciar o processo de teste e calibração, é preciso determinar a porta COM- para 

conexão Bluetooth entre o módulo scanner laser e o PDA. O procedimento é descrito no manual 

do adaptador Bluetooth. 
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30.1. Preparação para teste/calibração 
 Instale o sofwtare RF505Calibr no PC 

 Instale o adaptador Bluetooth entre o módulo laser e o PC 

 Posicione o perfilômetro na unidade de calibração  

 Execute o programa RF505Calibr 

 

 Para instalar a conexão Bluetooth, selecione a porta  

 

 O dispositivo será detectado e os parâmetros de calibração serão lidos.   

 

 Para executar a medição, passe para a aba Profile e clique Measurement. Após a 
medição, o display mostrará o perfil medido e os parâmetros geométricos calculados: 
Altura (Sh), Espessura (Sd), Ângulo (qR). Os parâmetros são medidos nos pontos de 
suporte L1, L2, L3.  
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 Para comparar com a referência, selecione a caixa Compare e escolha 
o perfil de referência na lista Reference que se abrirá.  

30.2. Teste 
Para executar teste automático, siga os seguintes passos: 

 Selecione a caixa N Meas. (número de medições) 

 Especifique o número de medições (5-10) 

 Des-selecione a caixa Calibr.,  caso esteja selecionada 

 Clique no botão Measuring 

 
 O módulo laser fará o número de medições especificadas, cujos resultados 

serão adicionados à tabela (na aba Data). As primeiras 3 colunas apresentarão 
os valores medidos de altura (Sh), espessura (Sd), e inclinação do flange (qR), 
enquanto as outars três colunas apresentarão os desvios dos valores medidos 
para os valores referência (d_Sh, d_Sd, d_qR). A aba Diagram mostra um 
diagrama dos valores/desvios do perfil medido em relação à referência 
selecionada. O desvio dos valores de referência para altura do flange e 
espessura não devem ser superiores a 0.1 mm.  

 Se os desvios excedem o valor permissível, é preciso executar a calibração do 
scanner. 

30.3. Calibração 
Para executar a calibração automática, siga os seguintes passos: 

 Selecione o perfil de referência da lista 

 Execute a medição (botão Measuring) 
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 Execute a calibração (botão Auto calibration) 

 Quando o escaneamento é concluído, execute o procedimento de teste de 
acordo com 30.2. Em caso de resultado positivo, passe para a aba Parameters 
e salve os parâmetros (botão Write parameters) 

 
 Se os parâmetros tem valores incorretos (negativos ou zero) por alguma razão, 

é preciso restaurar os ajustes de fábrica Pressionando o botão Load Default. 
Em seguida, recalibre o perfilômetro. 

 
Figure 1A 

31. Garantia 
A garantia do equipamento é de 12 meses, exceto para itens de desgaste ou 

danos devido a mau uso ou acidentes. 
 

32. Distribuidor e Suporte Técnico no Brasil 

CAPI Controle e Automação 

Rua Itototó, 121 
Americana-SP, Brazil 

Tel: +55 19 3604.7068 
Fax: +55 19 3468.1791 

capi@capicontrole.com.br 
www.capicontrole.com.br 
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